USING DNR GARMIN PROGRAM

The DNR Garmin Program was created by the Minnesota Department of Natural Resources (DNR),
MIS Bureau - GIS Section. This document will describe how to use the DNR Garmin program to
download and save Garmin GPS data to text and GIS shape files. It works as both a stand alone
program and also as an extension within ArcGIS 9.x software. The DNR Garmin extension no longer
works in ArcGIS 10.x, but can be run as a stand-alone application to meet your needs. It also will not
interface with newer Garmin GPS units, but the newer DNRGPS application will. Other features of
the program can be found in the detailed documentation which can be accessed by selecting DNR
Help File Index in the Help menu of the program. Both DNR Garmin and DNRGPS can be
downloaded from the Minnesota DNR website at:
http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html

To download the latest version of DNR Garmin, click the appropriate link at the bottom of the DNR
Garmin web site. If you have a previous version of DNR Garmin installed on your computer, there
is no need to uninstall prior to installing the new version. The latest version will install over the
previous version.

Installing DNR Garmin and DNRGPS Programs

1. The DNR Garmin setup ZIP file contains three files that are used for program installation. You
must unzip these files into the same folder to ensure proper execution of the installation program.

2. Once unzipped, double-click the .exe file that contains the words setup in its file name to start the
installation process.

3. Let the installation program place all the files in the default directory that it recommends.

4. The installation program will create an icon on the desktop for starting the program.

5. DNRGPS is a stand-alone executable application and no installation is necessary, but for quick
access, it’s best to store it and all accessory folders/files in a permanent folder and then create a
shortcut to the “dnrgps.exe” file.

Features of the DNR Garmin Program and Extension

1. Downloads and uploads waypoint, track and route data from and to GPS.

2. Users can save downloaded GPS data as text, shapefiles, .dbf, KML, GPX files.

3. Works with most older Garmin GPS units (60 and 76 series, first generation eTrex, and other
older models).

4. Functions as a stand-alone program to work independent of ArcGIS.

Setting Up the DNR Garmin Properties

1. Start the DNR Garmin program.
2. 'You must first set the desired projection for shapefiles or to match text files that will be loaded
into DNR Garmin.

A) To set the projection, in the DNR Garmin program window, select File = Set Projection.
This opens the DNR Garmin Properties dialog box where the properties for the projection,
waypoint, track and other settings can be set.

IMPORTANT NOTE: The desired projection must be set prior to downloading GPS data from
a GPS in order for it to properly project in the shape, text KML or GPX file. When loading a
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http://www.dnr.state.mn.us/mis/gis/tools/arcview/extensions/DNRGarmin/DNRGarmin.html

shape, text, KML or GPX file that was created by DNR Garmin, the projection set when the file
was created must be set prior to loading the file into DNR Garmin, otherwise it will not project
properly in any file types created from the data that was loaded.
B) The DNR Garmin Properties window will open
with the Projection tab selected.

1)

2)

There are three projection lists to choose from,
EPSG, ESRI and ArcMap. The EPSG option
lists projections based on their datum. The ESRI
list contains the standard projection list that
comes pre-loaded with ArcGIS. The ArcMap
option uses whatever projection is loaded into the
PRJ Definition box. It is recommended to use
the ESRI option if you expect to change
projections on a regular basis. From that list,
choose the desired projection (example:
NAD1983 California_Teale_Albers).

In order to have DNR Garmin generate a
projection file (.prj) for shapefiles created by the
program, you must have the ESRI projection file
for the desired projection saved on your
computer.

a) To load a projection file, click the Load PRJ
button on the lower right side of the
Projection Properties dialog box.

Navigate to the folder where the projection is
stored, select the desired projection file and
then click the Open button (the Teale Albers
projection is the NAD 1983 California (Teale)
Albers.prj file in the \Projected Coordinate
Systems\State Systems folder).

The projection parameters from the .prj file will
be loaded into the window below the Load PRJ
button. Once a projection is loaded for a
specific projection, the projection parameters
will be saved and always be displayed in the
window below the Load PRJ button when that
projection is set.

If window below the Load PRJ is empty, no
projection is loaded and a .prj file will not be
created for exported shapefiles.

b)

d)

C) See instructions at the end of this document for
accessing ESRI .prj files in ArcGIS 10.1 or later and
information on using DNRGPS with newer GPS units.

3. You can select the fields that you want to have in the
shapefile tables or text files for Waypoints, Tracks, Routes
and Real Time data (RTimeWpt). The default is for all to
be selected, which is more than you probably want.
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A) If not open, open the DNR Garmin Properties window by selecting Waypoint Properties,
Track Properties, Route Properties or Real Time Properties (not available after ArcGIS
10.1) from the respective feature type drop-down menu.

Select a feature type by clicking the respective tab.

Place a check in the boxes to the left of each field that you want in the table. Some of the
fields are “required fields” which can’t be excluded from the table.

Reducing the number of fields will result in a smaller table for easier viewing and smaller
DBF files.

Perform this task for each feature type that you intend to download.

In the ArcMap tab, do not check the Calculate Area option since it is not recommended to
save tracks as polygons. Checking the Calculate Length/Perimeter option may not result in
accurate calculations.

G) Keep the default options in the Units tab.

H) Click OK when done.

If the projection that was selected is not displayed in the box to the right of the Connection Status
box (bottom left corner of program window), select Get Projection from the File drop-down
menu. The current projection will now be displayed.

B)
C)

D)

E)
F)

Downloading Waypoint Data
SRR

connected to
your computer, File GPS | Waypoint Track Route Real Time  Help

=101 x|

waypoints can GPSMAP IECLLEE 1 VERBMAP Americas Highway 2.00
be downloaded Lat Uploa
by selecting Alt Waypoint Propetties
Waypoint > | Conmected | Table has been cleared y
Download.
& MN DNR - Garmin with Arc¥iew =101 =]

A) The bottom center
window in the
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Fil= Edit

GRS Waypoink Track Rouke Real Time Help

GPSMAP 765 Software Yersion 3.50 YERBMAF Amencas Highway 2 .00

. . Lat Lon

will display the Alt EFE <<« Data Table <<<

number of

waypoints received f* ‘W appaoint " Track " Route " RTimewpt

as it downloads. . tupe ident lak long Y poj &~
B) Once all of the 1 1| 48.86437772| -114.35807364

waypoints have IR R T

been downlo_added, + 4| wiayPOINT 4| 48.88183957| -114.33952927

a message window 5| st POINT 5| 48.85125141| -114.33976651

will pop up B[ wiaTPOINT B| 48.85145652| -114.34209002
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2. If the table is not already visible, you can view the waypoint table by clicking the <<< Data
Table <<< button on the right side of the program window.
A) Entries in the table cells can be changed as follows (normally not recommended):
1) Double-clicking the desired cell.
2) Entering the new information in the Modify Cell Value window.

Modify Cell ¥alue

Change " alue to:

x|
_Corcel |

Cancel

3) Then click OK to implement the change.
B) Waypoints can be selected and deleted by:

1) Select waypoints by clicking on the number in the left column.
2) Multiple adjacent waypoints can be selected by first selecting one waypoint and then hold
down the shift key.
3) Click on the desired waypoint above or below the first waypoint to select all those
between the two. -
4) Click the Delete selection button at the left side of the table to delete the 21 =h
waypoint(s). =L
5) To delete columns or rows in the table, use the same process as used to E1D EE
delete a waypoint, but select the columns by clicking on the field name at the top of the
column or rows by clicking the record number.
MNDWR Garmin S =15

Downloading Track Data

File GPS '-.-'-.-'a*;.-'pu:uintlTrack Route Real Time Help

1. GPS track files can be GPSMAP 765 S ofty I BMAP Americas Highway 2.00
downloaded by selecting Lat Lg Upload
Track - Download. Alt i [m—— >»> Data Table 3>
| Connected | | &
% Track " Boute = BTimewpt
ident lat long Y proj .
4CTIVE LOG 37.74994512| 12057765454 9536.58
4CTIVE LOG 37.75050402] 120.57741880(9574.69
ORI NRGarmin x| [2057741880/9579.46
ACTIWE 20 57735443 9551 .88
A) The bottom center window in the program 4CTIVE  Received 355 records. |20.57679653|9517.96
window will display the number of track points &CTIVE 20.57664633| 3623.36
. ACTIWE 20 57576556 97158.69
B) dOnce Iall(;)fdthe track pomt§ r&ave bg(laln 4CTIVE TOG 7 702 3AA 120.57553053] 974029
ownloaded, a message window will pop up 4CTIVE LOG | 37.74851574| 120 57527304| 9785 74
displaying the number of records received. SCTIVE LOG | 37.74855137| 120 57516575 9792.96
Click OK in this window. ACTIIC | Oz 27 7401cr1al 190 E7aancac| aooc n':-lj
3
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2. If not displayed, you can view the track table by clicking the >>> Data Table >>> button on the

right side of the program window.

a MNDNR - Garmin i
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A) Records (Rows) that are lightly shaded blue denote the first track point of a new track line
segment and will have the word True in the new_seg column.

This occurs when:

1) The GPS was turned off and then on again while the track function is turned on.

2) Satellite signal was lost and regained.

3) Active track recording was turned off and then on again.

C) When the data is saved to a shapefile, new line segments will start at this point and end the
record before the next shaded record in the table.

If you would like to join adjacent segments into one feature, follow these steps:

1) In the column titled new_seg, double-click the word True in the record that starts the new
segment that you would like to join to the previous segment.

In the Modify Cell VValue window that appears, type False, then click OK. The blue
shading will then disappear.

The adjacent segments will now form one feature when saved to a shape file.

Track points can be selected and deleted by using the same method as discussed in the
waypoint section above.

Columns in the table can be deleted using the same method as discussed in the waypoint
section above.

11

=
J7
| Comnected |

| 0 of 355 Selected 4

B)

D)

2)

3)
4)

E)

Saving GPS Waypoint or Track Data to Text and Shape Files

Having the capability to run DNR Garmin as a stand-alone program is a very useful capability when
trying to gather GPS data from personnel that don’t have GIS training and/or are collecting GPS data
from a distant location. Downloaded data can be saved to text files, which then can be attached to an
email or posted to FTP sites for quick retrieval. Text files created by the DNR Garmin program are
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software specific and probably won’t work with other GPS data export/import programs without

being edited. It is also recommended to use text files to backup original GPS data just in case shape

or other files created by the data become corrupt. DNR Garmin waypoint and track text files can be
loaded back into the DNR Garmin program to create new shapefiles to recover data that was
corrupted or to upload data back into the GPS ( Waypoint - Upload or Track - Upload). This is
useful if you want to check up on things in the same area later (using Goto or TracBack GPS
functions).

1. Follow the instructions noted above for downloading and editing waypoint or track data in the
DNR Garmin Program. Once you have finished editing the table, use the following steps to save
the GPS data as text, dbf or shape files. Remember that the desired projection must be set
prior to downloading GPS data from the GPS. If it is changed after downloading GPS data,
it may not be projected properly in the files that are created.

2. The steps below show how to save GPS data to text or shape files.

A) Select File &> Save To - File to open the Save As window.

# MNDNR - Garmin / Arcview / ArcMap
FIEM Edit GP5  Waypoink Track Rouke Real Time Help

Load From ¥ Warcinn 2 70 VERRWAP Americas Rec Basemap 4.00
File,
Sek Pr'I:IjEI:tiI:II'I Arciiew 4 {44 DEItEI TEIblE £44
Sk ArcMap k
et Projection .
" Route i RTime\wpt
General Properties el ltime »
Archap 9. Properties 3 apBOCS= 1333,/ 2430170000
8 5 00/12/31-00:00:00] GPSMapB0OCSx | 1999412430 17:00:00

BEMESNAPES £9/12/31-00:00:00| GPSMapBOCSx| 1989412430 17:00:00

Set App RefreshRate oo 5 a1 00:00:00] GPSMapEOCS=|  1989/12/3017-00:00

Exit £09/12/21-00:00:00) GPSMapB0CSx| 1989412430 17:00:00
T T or—r283/12/31-00:00:00] GPSMapBOCS=|  1989/12/3017:00:00

B) In the Save As window:
1) Select the desired folder that you would like to save the file.
2) Name the file in the File name: box — Place the following information in the file name
inserting underscores (_) between each item in the file name:

a) Date (YYYYMMDD)

b) Time (HHMM)

c) Incident name and number (no need to include zeros before #) if incident data or
project name if data is for a project.

d) GPS feature type (for track data, use GPS_lin and waypoints use GPS_pnt)

e) What you GPSed — fire perimeter (per), dozer line (dzr), hand line (hand), etc.

f) Your position on incident (FOBS, DIVS, etc.) and name — person using GPS (First
name initial and last name).

g) Abbreviation of the projection and datum used for the data (example: TealeNAD83 for
the NAD 1983 California (Teale) Albers projection). As noted before, include the
projection in all file names (shape, text, KML, GPX, DBF) so it can be set and
project properly if loaded into DNR Garmin or DNRGPS in the future.
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Track GPS text file name example:

20061214 1600 HogFire CATCU2456_GPS_lin_per_fobs JDoe TealeNADS83.txt
Waypoint GPS file name example:

20061214 1600 HogFire CATCU2456_GPS pnt_origin_fobs_JDoe TealeNAD83.txt

Organize v New folder e (7]

Mame Da
o Libraries
] Documents Ma items match your search
J’- Music [
k=| Pictures

=|
E Videos —‘
v@ Hamegroup

% Computer

Sl Local Disk (C:h ~ | i b

File name: 20061214 1600_HegFire CATCU2456_ GP5_lin_per_R5trazzo_TealeMADS3. bt -

Save as type: | Text File (Comma delimited) (* ) v]

“ Hide Falders [ Save l [ Cancel l

3) To save GPS data to a text file — In the Save as type: box at the bottom of the Save As
window, click the down arrow and select Text File (Comma delimited) (*.txt).

4) You can save to the other file formats later by selecting the desired format listed in the
“Save as Type” list. If you are saving to a projected shapefile, you must select the desired
projection and load the PRJ prior to using this option.

5) Then click the Save button to save the GPS data to the desired file type.

6) Click OK in the following window that notes the file was successfully saved.

7) If the data was saved to a text file, it can be loaded into the DNR Garmin program at a
later time and saved to another file type. If it was saved to a projected shapefile, it can be
loaded into any GIS software product that supports shapefiles.

3. Saving GPS data to projected shapefiles. The process shown below is for tracks, which has the
additional Output Shape options to choose. Exporting waypoints excludes these options.
A) Select File > Save To - File ... to open the Save As window again.
B) When the Save As window opens, select the desired folder and name the file using the
procedures described above, but make sure the file extension is .shp at the end of the file
name.
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C) Inthe Save astype: | |,ipiskicy
box at the bottom of | wp TooLs iy
the Save As window,

- 4 [ Tt d 3

CI |Ck the down arrow File name: 20061214 1600_HogFire CATCU2456_ GPS_lin_per_RStrazzo_TealeMNADE3.shp -

and Select ArCVi@W Save as type: | ArcView Shapefile (Projected) (*.shp) -
. ArcView Shapefile (Projected) (*.shp)

Shapefile ArcViiew Shapefile (Unprojected) (*.shp)

- * ide Falders DBase IV (*.dbf)
(PrOJeCtEd) ( Shp) Text File (Comma delimited) (*.td)

and then click the I Tt File (Semicolon delimited) (*:bd)
H Google Earth Format (*.kml)

Sa_'ve bUtton’ WhICh GP5 eXchange Format (".gpx)

will open the Output Lowrance Export Text File (*.txt)

Shape dialog box.

D) When the Output Shape dialog box opens, it should already
have Line selected as the output shape type. If not, select Line JERUUGINEIENE
and then click the OK button. Saving GPS track data to a line Please Define the Dutput Shape
shape file is the recommended, unless you would rather use ¢ Paint
points. Never select Polygon since the errors that may be ? g“le
present in the data may result in creating multi-part polygons, g
which may be difficult to edit.

E) When the message stating that the shapefile was successfully created appears, click the OK
button.

Uploading Data from DNR Garmin Program to a GPS

DNR Garmin can be used to upload waypoint, track or route data that has been loaded into the
program to a GPS that is connected to your PC.

IMPORTANT: As mentioned before, prior to loading the data into DNR Garmin, you must set
the projection in DNR Garmin to match the actual projection used by the GIS data. Otherwise
the data may not project properly when uploaded to the GPS or saved to other file types.

& MM DNR - Garmin f Arcview [ ArcExplorer [ A

1. To upload track data, select Track - Upload. Fle Edit GPS Waypoint | Track Route Real Time

GPSMAP 765 Softwarey  Download
Lat 38.4822991%on -11 e
Alt EPE

Track Properties...

2. To upload waypoint data, select Waypoint - Upload, and to upload route data, select Route >
Upload.

3. If you would like to have your track or route data uploaded as waypoints, click the Waypoint
radio button to convert data to waypoints. You can use this method to convert waypoint, track or
route data to any other type prior to uploading.

% il appoink = Track " Foute
hpe ident lat long
WATPOINT 1| 3290440731 -116.38

4. You can also load data from a shapefile and then upload the data to a GPS (or use DNR Garmin
to save it to a different file type).
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Using DNRGPS and Accessing ESRI .prj Files in ArcGIS 10.1 or Later

DNR Garmin can be used with older GPS receivers, but many newer models no longer work with
DNR Garmin. DNRGPS, the latest release of the software, can be used for downloading newer
models. The look and way both programs run is very similar. The main difference is found when
setting the projection. In DNRGPS, you must first select the desired datum in order for the list of
projections to display in the Projections window. Because issues have been found with DNRGPS
when working with some projections and there have been problems associated with saving GPS data
to some file types, the recommended software is DNR Garmin. To ensure proper “project on the fly”
functionality in ArcGIS for data created by DNRGPS, it may be necessary to redefine the appropriate
coordinate system in ArcCatalog or the Catalog in ArcMap. Doing this will ensure the coordinate
system name in the PRJ file matches the names recognized by ArcGIS. When GPS receivers fail to
connect using DNR Garmin, use DNRGPS.

The ESRI Coordinate systems files (.prj) used by the Load PRJ function in the Set Projection
options in DNR Garmin are no longer easily accessible in ArcGIS 10.1 and later versions. They were
normally stored in a subfolder of the “\Program Files (x86)\ArcGIS” folder, but are now stored in the
software code. These files when loaded into DNR Garmin with the Load PRJ tool are used to create
the .prj files for shapefiles created by DNR Garmin. If you don’t use the Load PRJ function to load
the PRJ, no .prj file will be created for projected shapefiles created by DNR Garmin. In order to
access the ESRI .prj files in ArcGIS 10.1 or later, you must add the desired coordinate systems to
your Favorites coordinate systems list by right clicking on the desired coordinates system in the
coordinate systems list and selecting Add to Favorites. Once this is done, you can access the .prj file
under your user profile in the "Users\{your user
nameAppData\Roaming\ESRI\Desktop10.1\ArcMap\Coordinate Systems" folder. With versions of
ArcGIS other than 10.1, change the version in the above path to the version installed on your
computer.

December 2017 RJS 9



	Using DNR Garmin Program
	Installing DNR Garmin and DNRGPS Programs
	Features of the DNR Garmin Program and Extension
	Setting Up the DNR Garmin Properties
	Downloading Waypoint Data
	Downloading Track Data
	Saving GPS Waypoint or Track Data to Text and Shape Files
	Uploading Data from DNR Garmin Program to a GPS
	Using DNRGPS and Accessing ESRI .prj Files in ArcGIS 10.1 or Later




